Sun ONE Meta-Directory Release Notes

Version 5.1.1 May 2004
Part Number 817-3899-10

These Release Notes contain important information available at the time of release of Sun ONE™
Meta-Directory 5.1.1. New features and enhancements, known issues and limitations, and other
information are addressed here. Read this document before you begin using Meta-Directory™
5.1.1.

The most up-to-date version of these release notes can be found at the Sun ONE documentation
web site: ht t p:// docs. sun. com db/ prod/ sunone#hi c. Check the web site prior to installing and setting
up your software and then periodically thereafter to view the most up-to-date release notes and
product documentation.

These release notes contain the following sections:
= Release Notes Revision History
= About Meta-Directory 5.1.1
< Bugs Fixed in This Release
= Important Information
= Known Issues and Limitations
= Redistributable Files
< How to Report Problems and Provide Feedback
= Additional Sun Resources

Third-party URLs are referenced in this document and provide additional, related information.

NOTE Sun is not responsible for the availability of third-party web sites mentioned in this
document. Sun does not endorse and is not responsible or liable for any content,
advertising, products, or other materials that are available on or through such sites
or resources. Sun will not be responsible or liable for any actual or alleged damage
or loss caused by or in connection with the use of or reliance on any such content,
goods, or services that are available on or through such sites or resources.
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Release Notes Revision History

Release Notes Revision History

Table 1  Revision History

Date Description of Changes

May 28, 2004 Initial release of these Release Notes

About Meta-Directory 5.1.1

Sun ONE Meta-Directory synchronizes and consolidates data stored in various repositories such as
the Sun Java System™ Directory Server. Meta-Directory can be used to create and delete accounts
in various enterprise and extranet applications. By unifying the information about user identities to
a single authoritative directory server, Meta-Directory reduces the cost of management, acts as a
single point for applications to search and access identity information, and it also ensures this
information is consistent. Supported data sources include LDAP directories, Oracle databases,
Microsoft Active Directory, Novell eDirectory, and other proprietary formats.

This section includes:
e What’s New in This Release
< Hardware and Software Requirements

= About Scalability Limits

What's New in This Release

The focus of this release has been to improve the product stability and quality; more than 150 bugs
and 40 ‘memory leak’ related bugs have been addressed in this release. Issues that affected
inter-operatability with several key data sources have also been corrected, expanding the list of
supported data sources.

Some of the key highlights are:

= Underlying software components are aligned with the Sun Java Enterprise System 2 for
improved compatibility.
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About Meta-Directory 5.1.1

NSPERL is updated to version 5.8.2 which supports multi-threading. This improves the
stability when running external PERL scripts.

‘Scheduling’ feature is fixed to work as documented.

The Administration Server and Console is updated to the latest version, to improve
memory usage and provide better compatibility with Directory Server 5.2.

Support for new data source versions:

o Lotus Notes 5.0.10, 5.0.12, and 6.0.1

NOTE

Support for 6.0.1 is limited to 1000 users due to a bug in the Lotus Notes LDAP
interface. For more information, see bug #4910198.

o Oracle9.2.0
o Novell eDirectory 8.7

Due to Sun Java System Directory Server 5.2 dropping support for running on Windows
NT, Meta-Directory had to drop support for running on Windows NT 4.0. However,
Meta-Directory retains the capability to synchronize data to and from Windows NT 4.0
Primary Domain Controllers.

Hardware and Software Requirements

The following hardware and software is required for the Meta-Directory Join Engine. Individual
connectors to the data sources may have additional requirements.

Table 2  Solaris Hardware and Software Requirements
Component Platform Requirement
CPU UltraSPARC™ || (32-bit and 64-bit), 400Mhz or higher
CL)JrItraSPARCT"’I I1li (32-bit and 64-bit), 400Mhz or higher
Operating System Solaris™ 8 or Solaris 9
and recommended service packs
RAM Minimum: 512MB
Recommended: 1 GB or 2 GB
Disk space Minimum: 100 MB

Recommended: 1GB
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Bugs Fixed in This Release

Table 2  Solaris Hardware and Software Requirements (Continued)

Component Platform Requirement

Sun Java System Directory Sun Java System Directory Server 5.1
Server or
Sun Java System Directory Server 5.2 Hotfix 1

Table 3  Windows Hardware and Software Requirements

Component Platform Requirement
CPU Intel Pentium | | or later (IA-32 processors), 300 Mhz or higher
Operating System Windows 2000 Standard Edition, SP4

Windows 2000 Enterprise Edition, SP4

RAM Minimum: 512MB
Recommended: 1 GB or 2 GB

Additional software Minimum: 512MB
Recommended: 1 GB

Sun Java System Directory Sun Java System Directory Server 5.1
Server or
Sun Java System Directory Server 5.2 Hotfix 1

About Scalability Limits

Maximum number of entries supported in the Meta View is 500K entries.

Bugs Fixed in This Release

The table below describes the bugs fixed in Meta-Directory 5.1.1:
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Bugs Fixed in This Release

Table 4  Fixed Bugs in Meta-Directory 5.1.1

Bug Number

Description

Upgrade/Installation/Uninstallation

4885441

4893447

4977366

Administration

4965491

4965492

4966231
4966174

Console

4887756

4886281

4804752

4929992

4919528

General

4920132

Join Engine

4760313

On Windows 2000-based machines, Meta-Directory 5.1 could not be installed using the set up. exe
file. The installation program was terminated unconditionally, and the message ‘Please go to the
Control Panel to install and configure your system components’ was displayed.

On Windows-based machines, the installation program failed when attempting to install to a
directory (SERVER_ROOT) that contained a space in the directory name, including the default
installation directory, Program Fi | es.

Executing the upgrade script led to the ‘Cannot access nsperl544.zip’ error, and the upgrade tool
failed to complete the operation.

Accessing Help in the Fixittool > Authentication window had resulted in the
‘Java.lang.NullPointerException’ error.

Text fields in the Fixittool > Authentication window did not contain labels that helped in entering
appropriate data in the fields.

The value for the Maximum Disk Usage field in the log files for the Join Engine were blank.

An error message that contained a typographical error was displayed when a Constructed Attribute
name was created with spaces.

The ‘ArraylndexOutOfBoundsException’ error had occurred when the Continuous option in the
Console > Log window was selected to view the log files.

Incorrect naming attributes were displayed when the entries of the Connector View (Meta-Directory
> Connector Views > <UTC CV>) or Meta View (Meta-Directory > Join Engine > Meta-View) were
viewed using the Meta-Directory Console.

In the Console, the Join Engine’s status was displayed as ‘unknown’ although its actual status was
either ‘started’ or ‘stopped’.

The Console used to set the Filter configuration value to nul | if Def aul t was selected in the
General tab.

The changes made to the parameters in the Schedule tab (Meta-Directory Console > Connectors >
<any connector> > <CV> > from the right pane, click Schedule tab) were reset to the previous values
when modifications were made to the operation settings in the General tab.

The options in the Advanced Schedule dialog box (in the Schedule tab > click Advanced) did not
work as documented when setting the schedule for the synchronization of entries.

Special characters, spaces, and # were not escaped when creating the Distinguished Name (DN) of
entries in the LDAP Directories. See RFC 2253.
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Bugs Fixed in This Release

Table 4  Fixed Bugs in Meta-Directory 5.1.1 (Continued)

Bug Number Description

4832692 When the Join Engine attempted to start up, Meta-Directory shut down with the ‘Dr. Watson’ error
on Windows-based machines.

4877779 If a joined entry was deleted, the entry used to get deleted in the Meta View too and it was also
added to the owner. This resulted in the entry not having the attributes that were flown to other
Connector Views.

4719673 The Join Engine used to always check for changes during start up regardless of the DCNS
schedule.

4910331 During synchronization, due to large number of groups in the Oracle Connector View, Join Engine
shut down with the ‘DCNS_E_TOO_LATE’ error and the Connector View was disabled.

4940810 The Join Engine shut down when synchronization of entries was performed from the LDAP
Connector View to the Meta View on a single CPU machine.

4924479 When the DN Mapping rules failed to meet the syntax requirements or was set to ‘none’, the Join
Engine had retried the mapping rules three times and then logged an error to the log files. This had
resulted in reduced performance of Meta-Directory.

4944688 The Join Engine stopped responding when the refresh operation for groups that contained large
number of members, for instance, more than 100K entries, was performed for the LDAP Connector
View.

4918670 The Join Engine shut down when the refresh operation (if the Oracle database contained a table
with large number of columns, for example, more than 500) was performed in the Meta View to the
Connector View flow direction.

4878283 The Join Engine shut down when flowing data from multiple connectors simultaneously.

4969815 When adding an entry to the Meta View failed, the Join Engine attempted to incorrectly retry the
‘mapping rules’ three times. This led to reduced performance of Meta-Directory.

4938779 The Join Engine shut down abruptly when a large number of entries (for example, more than 500K)
were flown from the Connector View to the Meta View.

4958886 Information displayed in the Total number of Meta Views field (Join Engine > select Statistics tab)
was not accurate.

4935125 When the Log Level (Join Engine > Log > Log Level) was set to Off, Join Engine still continued to
report the log files.

This occurred when the Log Level was changed from the Debug or Normal mode to the Off mode or
when the Join Engine was started with Log Level set to Off.

4954367 When data was flown from an LDAP Connector View to the Meta View (if the Meta View is on one
Directory Server instance and the LDAP Connector View is on another Directory Server instance),
and if Directory Server hosting the Connector View was shut down, the Join Engine shut down
abruptly. The Log files did not report the cause of the error.

4956616 When an entry was deleted in the Connector View and then a DN mapping rule was applied, Join
Engine shut down.
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Bugs Fixed in This Release

Table 4  Fixed Bugs in Meta-Directory 5.1.1 (Continued)

Bug Number Description

4844931 After a refresh operation, the owner of an entry was changed to an incorrect Connector View (when
the entry from the original Connector View was shut down).

4925961 When an event script used the ‘localtime()’ function, Join Engine had shut down.

4938633 When both the Connector View and the Meta View used dc=<>, the Join Engine shut down due to
an ‘Object_Class_Violation’ error.

4923256 Entries from the Connector View to the Meta View stopped flowing after a few entries were flown
and the Join Engine had shut down if a large number of DN mapping rules existed.

4793456 In the Connector View, the entire directory information structure (DIT) of an entry was displayed
under each entry.

4959422 The log files on a Solaris-based machine had incorrectly reported the ‘nsmds:daemon.error
PR_Open(start.conf)’ error although the start. conf file was available.

4800813 When executing the Perl scripts, the Script Here option that was used to specify the location of the
perl scripts did not work.

4947644 When several Participating Views were enabled, Join Engine shut down due to a ‘nsmds’ error.

4926008 Join Engine shut down when flowing two million or more entries from an Oracle database to the

Connector View.

Active Directory and Exchange Connector

4815651

4833345

4897015

4964191

4970338

4918763

4960161

4917915

Incremental mode has been implemented in the Active Directory and Exchange connector.

This is the default mode. In this mode, the connector detects only new and modified entries in the
Active Directory and flows it to the Connector View.

For more information on this and the other modes, see the table in “To set configuration parameters
from the configuration file” section in the Meta-Directory 5.1.1 Administration Guide.

When the Active Directory administrator password was stored in the adc. i ni file, it was not
encrypted.

If no value was entered in the ‘sn’ field in Active Directory, user entries from the Active Directory
connector did not flow to the Connector View, on synchronization.

An entry that contained the hypen character did not flow from the Connector View to Active
Directory, for example, cn=cn- 1- user nane.

The Manual Refresh operation failed when executed for the Connector View to Active Directory flow
direction.

Due to an incorrect mapping of the enpl oyeel D attribute (in Active Directory) with enpl oyeenunber
in Directory Server, data did not flow to the Connector View, on synchronization.

Values of the nsexchnai | boxsecuritydescri pt or attribute did not flow from the Connector View to
Active Directory.

Due to an incorrect mapping of the i ni ti al s attribute (in Active Directory) to the i ni ti al attribute in
the Directory Server, data flow for this attribute failed.

Part Number 817-3899-10 Page 7 of 38



Bugs Fixed in This Release

Table 4  Fixed Bugs in Meta-Directory 5.1.1 (Continued)

Bug Number Description

4915812 Data of the nsexchobj ect al ver si on attribute did not flow due to an incorrect search attribute
present in the adc. i ni file.

4916361 Values of the entries that contained the ‘Organization’ (o) attribute did not flow from Active Directory
to the Connector View, on synchronization.

4916556 Using the Default Attribute Flow mapping, the ‘memberOf’ attribute of a group DN did not contain

any value when flown from Active Directory to the Connector View.

NT Domain Connector

4910993

When creating an NT Domain Connector instance, no validation was performed for read-write
hostnames.

Universal Text Connector

4771792
4537752
4543794
4786815

4883004
4899815

4935861

4980172

4945344
/4947638

4919481

4901237

4635520

4901842

Renaming a RDN entry (ModRDN operation) is now supported in the Universal Text Connector.

The uni queMenber attribute was not escaped if the DN value contained UTF-8 data.

The Euro symbol in an entry was corrupted when the entry was flown to the external file (*.out). The
*.out file did not contain the actual Euro symbol.

Using a remote Console (if the console was running on a machine where Meta-Directory was not
installed), none of the options in the Log window could be modified. An error occurred when
attempting to modify any of the options.

The external file (*.out file) did not contain the complete data when a Manual Refresh operation was
executed in the Connector View to the external file flow direction.

Meta-Directory shutdown abruptly when several Universal Text connectors were started (with all the
Participating Views enabled), and the data did not flow from the Connector View to the Meta View.
The schedule was set to run every minute for a day.

Entries that had quotation marks, for example, char act er in their values were flown on
synchronization, however in the external file the values did not contain the quotation marks. This
occurred although the parameters Keep Quot es=TRUE and Quot eChar act er =" were appropriately set
in the t ask. cf g file.

When performing synchronization if the Mul ti Val ToNoVal At tr parameter in the t ask. cf g file
contained cn in its value, then the Universal Text connector shut down.

When performing the Refresh operation using filters (from the Connector View to the external
directory direction), the operation failed if the entries were 500K and more. The Universal Text
Connector did not shutdown gracefully.

When binary values of an entry that contained multiple values (a list of comma separated values),
on synchronization, the connector had failed to process these values.

Database Connector
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Bugs Fixed in This Release

Table 4  Fixed Bugs in Meta-Directory 5.1.1 (Continued)

Bug Number Description

4865897 Support for Oracle 9.2.0 has been implemented.
Note: See the “Compatibility Issues” section for limitations when using a 32/64 bit Oracle
client/server.

4913256 On Windows-based machines, the non-ASCII character set was not loaded properly when flowing
data from the Meta View to the Oracle database.

4937210 Entries that contained single quotation marks (‘) in the Directory Server were converted to double
guotation marks (“) in Oracle when synchronization was performed.

4987493 When the Join Engine was started and stopped within a short time interval, for example, 5 minutes,

and if the Oracle Connector View had more than 50 Connector Views, Meta-Directory had shut
down with an error.

Lotus Notes Connector

4927227

4940319

4897816

4882986

4799004

When flowing large number of entries from the Lotus Notes connector to the Connector View, the
‘sERR_LDAP_DA_003’ error occurred. Synchronization of the entries had failed.

When an entry was made to flow from the Directory Server to the Lotus Notes server, the user ID
file did not contain the correct user name information.

If the modification to nonRDN attributes and modification to RDN attributes (modRDN operation)
were performed simultaneously, the modified user entries did not flow to the Lotus Notes server.

When running the Manual Refresh operation on the directory tree (DIT), an error message was
displayed ‘Failed to submit the command to the connector. Ensure that it is running’. Due to this, the
refresh operation failed to complete.

When the attribute mappings list was viewed (Console > Connectors > Novell eDirectory Connector
> select Attribute Flow tab > Complete Attribute Set for Default Schema), it was not sorted
alphabetically.

Novell Connector

4897816

4799004

4973612

4900336

If the modification to non-RDN attributes and modification to RDN attributes (modRDN operation)
was performed simultaneously, the modified user entries did not flow to the Novell eDirectory
server.

When the attribute mappings list was viewed (Console > Connectors > Novell eDirectory Connector
> select Attribute Flow tab > Complete Attribute Set for Default Schema), it was not sorted
alphabetically.

When modifications were made to an entry from multi-value to no value, the modified entry did not
flow from the Connector View to the Novell eDirectory server.

The system stopped responding when multiple connectors where enabled and the synchronization
operation was performed.
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Important Information

Important Information

This section contains the latest information that is not contained in the core product documentation.
This section covers the following topics:

« |nstallation Notes
e Compatibility Issues

= Documentation Updates for Meta-Directory 5.1.1

Installation Notes

Before you install Meta-Directory 5.1.1, ensure that the following are installed and running:

e SunJava System Directory Server™ 5.1 or 5.2 HF1
Install Directory Server and Meta-Directory on separate machines for production use. In
the testing and development environment, it can be installed on the same machine (note
that this machine must comply with the recommended machine requirements, see the
“Hardware and Software Requirements” section for more information).

= Recommended Patch Clusters for Solaris 8 or Solaris 9
These patches must be installed on machines where any component of Meta-Directory (Join
Engine, Console, and connectors) is installed. For the latest patch clusters, access the
following link
http: //sunsol ve. sun. con pub- cgi / show. pl ?t ar get =pat ches/ pat ch- access

= Solaris Operating System patches for Java 2 Standard Edition™ (J2SE) 1.4.1 or higher
These patches must be installed on machines where the Console or the Java-based
connectors (Novell and Lotus Notes) are installed.
Localized JRE patch set can be downloaded from:
http: //sunsol ve. sun. coni pub- cgi / show. pl ?t ar get =pat ches/ J2SE

= C++ Runtime Objects
These runtime objects must be installed on machines where any component of
Meta-Directory (Join Engine, Console, and connectors) is installed. Download and install
these runtime objects from:
http://sunsol ve. sun. com pub- cgi / fi ndPat ch. pl ?pat chl d=108434&r ev=13
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Important Information

Installing on Solaris

CAUTION  This recommendation must be reviewed before you begin installing Meta-Directory
on Solaris-based machines.

Install in different server roots, when installing Meta-Directory 5.1.1 with Directory Server.

Installing on Windows

CAUTION These are important notes to consider when installing Meta-Directory 5.1.1 on
Windows-based machines. (#4878333)

< When installing Meta Directory 5.1.1 on the same machine where Directory Server 5.1
(any service pack installed) is installed, you must choose a directory different from the
Directory Server installation.

-Or -

< When installing Meta Directory 5.1.1 on the same machine where Directory Server 5.2 is
installed, you must choose the same directory where the Directory Server is installed.

Compatibility Issues

= Ensure that you review the following compatibility constraints when using Oracle 9.2.0
with Meta-Directory 5.1.1:

On Solaris
o Oracle 9.2.0 32 bit server and 32 bit client is compatible
o Oracle 9.2.0 32 bit client and Oracle 9.2.0 64 bit server is compatible
o Oracle 9.2.0 64 bit client/server only is not compatible
On Windows
o Oracle 9.2.0 32 bit server and 32 bit client is compatible
= Meta-Directory does not support Windows 2003 Active Directory
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Known Issues and Limitations

Documentation Updates for Meta-Directory 5.1.1

Documentation has been corrected to state the correct compatibility for Novell eDirectory
8.7.

Documentation has been corrected to state the correct compatibility for Netscape Directory
Server 4.x.

Key concepts and an introduction to the various components of Meta-Directory has been
consolidated in the new Product Brief manual. See Sun ONE Meta-Directory 5.1.1 Product
Brief for more information. Part number: 817-3895-10.

Installation Guide

Information on performing the upgrade procedure for this release of Meta-Directory has
been enhanced. See Chapter 5 of the Sun ONE Meta-Directory 5.1.1 Installation Guide, for
information.

Important information on uninstalling Meta-Directory on Windows has been enhanced in
Chapter 6 of the Sun ONE Meta-Directory 5.1.1 Installation Guide.

Before installing this release of Meta-Directory, ensure that you review the hardware and
software prerequisites. For more information, see the “Supported Platforms Overview” in
Chapter 1 of the Sun ONE Meta-Directory 5.1.1 Installation Guide.

Administration Guide

Name has changed from Sun ONE Meta-Directory Configuration and Administration Guide to
Sun Meta-Directory Administration Guide.

Procedure to use the Solaris 9 libthread on Solaris 8 is documented in the Sun ONE
Meta-Directory 5.1.1 Administration Guide. For information on this, see Appendix C, Table
C-15 in the “Common Problems” section. (#4912514)

Known Issues and Limitations

This section contains a list of the known issues with Meta-Directory 5.1.1. The following product
areas are covered:

Uninstallation
Upgrading from Prior Meta-Directory Versions

Installation
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Known Issues and Limitations

= General

= Configuration
= Console

= Join Engine

e Connectors

Uninstallation

Uninstallation of Meta-Directory 5.1.1 on Windows damages Directory Server 5.2 (#4884333)

When Directory Server 5.2 is installed in the same SERVER_ROOT (file system directory) as
Meta-Directory 5.1.1 (prerequisite when installing on Windows-based machines), uninstalling
Meta-Directory 5.1.1 will damage Directory Server 5.2.

Workaround
When uninstalling Meta-Directory, do not select the Server-Core Components and Administration
Services options from the list of components.

For more information, see the detailed procedure described in the “Uninstalling Meta-Directory
5.1.1 and Directory Server 5.2 if they Cohabit” section in the Meta-Directory 5.1.1 Installation Guide.

The changelog tables from the Oracle database are not removed after performing the uninstallation
operation (#4886138)

Uninstalling Meta-Directory without uninstalling the Oracle connector instances results in the
changelog tables not being deleted from the Oracle database.

Workaround

Before you begin uninstalling Meta-Directory, delete the configured Oracle data servers. This
generates the uni nst _<dat aser ver >. sql files. Execute these *.sqgl files to remove the changelog
database. For information on removing the sql files, see the Oracle documentation.

The ‘Join Engine’ service and the installation directory structure on Windows are not removed after
performing the uninstallation operation (#4895462)

Workaround
Ensure that you stop the “Join Engine’ service (from Start > Control Panel > Administrative Tools >
Services) before you run the uninstallation program.
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Known Issues and Limitations

After uninstalling Directory Server 5.2 on Solaris-based machines, the uninstallation operation fails
when attempting to uninstall Meta-Directory (#4949894)

‘ERROR. Failure uninstalling Meta-Directory Join Engine’ may occur when uninstalling
Meta-Directory. This occurs because the uninstallation program is attempting to locate the
configuration directory which was available on Directory Server 5.2.

Workaround
Before you uninstall Meta-Directory, ensure that the Directory Server containing the configuration
directory is available.

For specific details on uninstalling Meta-Directory on Solaris-based machines, see Chapter 6 in the
Meta-Directory 5.1.1 Installation Guide.

When the Meta-Directory Console is running, if the uninstallation program is executed, the
‘java.lang.ArraylndexOutOfBoundsException’ occurs (#4958843)

Workaround
Before attempting to uninstall Meta-Directory, ensure that you stop all the Meta-Directory Console
instances, all connector instances, and the Join Engine.

A message that contains a typographical error is displayed during the uninstallation of Meta-Directory
(#4950674)

When attempting to uninstall Meta-Directory with the Directory Server shutdown, the ‘A serious
problem occurred while uninstalling the Meta-Directory Join Engine Meta-Directory Join Engine. It
reported the following problem: No value exists for the name ‘ConfigDirectoryLdapURL’ error
message is displayed. ‘Meta-Directory Join Engine’ is incorrectly repeated twice in the error
message.

Upgrading from Prior Meta-Directory Versions

After upgrading to Directory Server 5.2 and Meta-Directory 5.1.1 from Directory Server 5.1 and
Meta-Directory 5.1, the user directory port is displayed incorrectly (#4930118)

After the upgrading and changing the new Directory Server port to a port number of the earlier
Directory Server, Meta-Directory Console continues to display the new Directory Server port
number prior to the upgrade.

After upgrading from Meta-Directory 5.0.1 SP1, an empty server group of Meta-Directory 5.0.1 is
displayed in the Console (#4899786)

When upgrading from Meta-Directory 5.0.1 SP1 to Meta-Directory 5.1.1 (on Solaris-based machines
with Directory Server 5.1 SP2), an empty server group of Meta-Directory 5.0.1 is displayed in the
Console. This server group does not contain any content nor any component.
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Known Issues and Limitations

Executing the upgrade script without any parameters does not display an error message nor prompts
you to enter the required parameters (#4942383)

The upgrade script does not validate whether any of the parameters are specified while executing
the script.

Workaround

Ensure that you enter all the required parameters while executing the upgrade script. For more
information on the required parameters, see the “Upgrading to Meta-Directory 5.1.1” chapter in the
Meta-Directory 5.1.1 Installation Guide.

Perl scripts that are used to configure the Universal Text Parser are not updated to the latest version

Workaround
When upgrading to Meta-Directory 5.1.1, update the perl scripts manually.

After upgrading from Directory Server 4.16 to Directory Server 5.2 and Meta-Directory 5.0 to
Meta-Directory 5.1.1, the ‘No nsHosts found in this admin domain’ error occurs (#4977282)

This occurs when the upgrade script is executed with the ‘restore’ parameter (upgr ade - R). The
upgrade operation fails.

The default decompression program could fail to decompress the upgrade script binaries (#4928711)

When performing the upgrade operation, the upgrade script uses a command-line program to
decompress the binaries. The upgrade operation fails if the upgrade script does not locate this
program.

Workaround

Execute the script with the required parameters. When prompted for the command-line
decompression program, make sure that you manually point to the location of the program. Once
the files are decompressed, run the upgrade script manually from the directory where the script
files was decompressed. For more details on this procedure, see the “Step by Step Upgrade
Example” section in Chapter 5 of the Meta-Directory 5.1.1 Installation Guide.

After upgrading from Meta-Directory 5.0 (SP1-P1) to Meta-Directory 5.1.1, the Console files of version
5.0 are not uninstalled on Windows (#5038214)

The Console files of Meta-Directory 5.0 are not removed from the Directory_Server_Root, after
uninstalling Meta-Directory 5.0. Due to this issue, after upgrading from Meta-Directory 5.0 to
Meta-Directory 5.1.1, two options to access the Console are available in the Program Files menu
(click Start > Program Files). The Program Files menu displays the iPlanet Server Products > iPlanet
Console 5.1 and the Sun ONE Server Products > SUnONE Server Console 5.1.1 options to access the
Console. (The iPlanet 5.0 Console will not work correctly if it is used to perform the configuration
related operations.)
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Known Issues and Limitations

Workaround
Ensure that you click Start > Program Files > Sun ONE Server Products > SUnONE Server Console
5.1.1 to start the Console. Use only this option to perform all the Console related operations.

After upgrading to Meta-Directory 5.1.1, the NT Domain connector does not start as the administrator
of the NT domain automatically on Windows (#5039688)

The upgrade script successfully creates the connector and the required service for the NT Domain
connector, however, the NT connector service does not automatically log on as the administrator of
the NT domain. The connector cannot be used to flow the data.

Workaround

Click Start > Control Panel > double-click Services > display properties for NT Connector service.
Edit the Logon User properties. Specify the appropriate Administrator credentials for the connector
service.

After upgrading to Meta-Directory 5.1.1, filter rules created using prior versions of Meta-Directory may
not be displayed correctly (#5038222)

The filter rules created using ‘All Subtrees Except’ and ‘No Entries Except’ option in prior versions
of Meta-Directory will not display the rules correctly in the Filter configuration window (for
example, in Join Engine > Filter Rules window). This is only a user interface issue. The filter rules
will function correctly.

Workaround
After performing the upgrade operation, you must review the filter rules manually and remove the
incorrectly displayed rules.

After upgrading to Meta-Directory 5.1.1, when attempting to start the Active Directory or Exchange
connector, the ‘Failed to get root DSE’ error is displayed (#5039681)

Due to this error, the Active Directory connector does not flow the data.

Workaround

Create a temporary Active Directory connector (which is not used to flow data), and then copy the
ADC. DAT file from its present configuration directory to the configuration directory of the original
Active Directory connector (that existed before the upgrade operation).

When upgrading from Meta-Directory 5.1 to Meta-Directory 5.1.1, the operation does not complete if the
Oracle Connector View has large number of entries (more than 500K) (#5038230)

Workaround

Disable the retro-changelog plug-in and then backup the cn=pr oxy

vi ews,ou=5, ou=net a- di r ect or y,ou=gl obal pr ef er ences,ou=<admin-domain>,0=net scaper oot tree
using the | dapsear ch command. Once completed, delete the cn=pr oxy
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Vi ews,ou=5, ou=net a- di r ect or y,ou=gl obal pr ef er ences,ou=<admin-domain>,0=net scaper oot tree
using the | dapdel et e command. Perform the upgrade operation using the upgr ade. pl script. Once
completed, restore the cn=pr oxy vi ews tree from the backed up data and then enable the
retro-changelog plug-in.

For complete details on executing this procedure, see Problem 1 under the Troubleshooting section in
Chatper 5 of the Meta-Directory 5.1.1 Installation Guide.

Upgrade.pl fails to upgrade to Meta-Directory 5.1.1 when the configuration (NetscapeRoot) is shared
(#5045826)

Workaround

Backup the Meta-Directory configuration and the File Systems, and then uninstall Meta-Directory.
Once completed, install Meta Directory 5.1.1, restore the configuration and File Systems from
backed up data, and then add new the configuration elements. Once completed, create the
Windows Service (for Windows-based system only).

This procedure is described in detail in Chapter 5 of the Meta-Directory 5.1.1 Installation Guide. See
Problem 2 under the Troubleshooting section, for more information.

Installation

The installation program fails when installing specific components such as Novell or Lotus Notes
(#4798001)

This issue occurs because the installation program does not automatically select the components
that Novell and Lotus Notes connectors require. The dependent components for Novell, Lotus, and
all the UTC-based connectors (Exchange connector, Active Directory connector, and so on) are the
‘Server Core Components’, ‘Administration Services’, ‘nsperl’, and the ‘Sun ONE Console’.

Workaround
You must manually select these components, when installing the Novell, Lotus, and the UTC-based
connectors.

Unable to start or stop the Directory Server using the Console on Windows-based machines
(#4995500)

This occurs because an incorrect administration domain was specified in the Login dialog box,
when Meta-Directory was installed.

Workaround
When installing Directory Server 5.2 and Meta-Directory 5.1.1 on the same Windows-based
machine, ensure that the administration domain is the same as the system domain.
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Meta-Directory 5.1.1 installation fails to install the components if LD_LIBRARY_PATH was set to
Directory_Server_Root/lib (#4798082)

If the LD LI BRARY_PATHenvironment variable is set to the Directory_Server_Root/ | i b path, then after
an installation of Meta-Directory 5.1.1, the ‘Create Instance of’ operation is disabled and, the Join
Engine and connectors cannot be created.

Workaround
Remove the reference of Directory_Server_Root/ | i b from the environment variables PATHand
LD LI BRARY_PATHon Solaris and from PATHon Windows, and then install Meta-Directory 5.1.1.

After installing Meta-Directory 5.1.1, Administration Server fails to start on Windows-based systems
(#5043790)

This issue occurs on restarting the machine (containing Directory Server 5.2 with HotFix1 installed)
after installing Meta-Directory 5.1.1. The Administration Server service does not start either
automatically or manually nor can the Console be used to perform any operation.

Workaround

Before you install HotFix1 of Directory Server 5.2, remove all the registry keys associated with the
Administration Server. After installing the Directory Server with HF1, be sure to restart the system
before you begin the installation of Meta-Directory 5.1.1.

General

The rename (ModRDN) operation on non-owned entries is not supported by indirect connectors such
as Exchange, Novell, or the Notes connector

The Join Engine, Oracle connector, and direct LDAP connectors can perform the rename
(ModRDN) operation on non-owned entries.

Selecting an external attribute does not automatically select the corresponding Connector View
attribute for the ‘To Connector View’ flow direction (#4847813)

The user interface does not display the attributes automatically.

After a connector instance is created, no message is displayed prompting you to enable the
retro-changelog plug-in before you begin using the instance (#4798636)

When creating the Novell connector instance if the Enable Changelog Later option is selected, a
confirmation message displays ‘Instance Creation Succeeded’. Although the connector instance is
created, the instance cannot be used until the retro-changelog plug-in is enabled.

To enable the retro-changelog plug-in, from the Directory Server Console > select Configuration >
Plug-ins > click Enable Plug-in > select Retro-changelog Plug-in and click Save.
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Instead of only the selected Connector, ‘Save’ operates on all the similar connector instances
(#4777417)

The ‘Default’ and ‘minimal’ configuration settings of a connector can be added, modified, or deleted,
although it is not recommended (#4801455)

When setting the Attribute Flow and Object Class Flow options, the ‘default’ and ‘minimal’ sets
(any Connector > select Attribute Flow > select the Configuration > click Add or Delete) can be
added, modified, or deleted. Although permitted, do not add, modify, or delete the ‘default’ or
‘minimal’ set. This may result in improper functioning of the connector.

Unable to delete entries from the Directory Server 4.16 Connector View (#4946127)

If you add an entry to the LDAP 4.16 Connector View, and then attempt to delete the entry from the
Meta-Directory Console, the ‘No such object’ error is displayed.

Performing the refresh operation from the Directory Server 4.16 Connector View to the Meta View does
not display the information about the group members (#4945383)

If an entry and a group is added to the Connector View, and then a member is added to this group
as a new entry, synchronizing to the Meta View only displays the ‘member name’. The ‘Member
user 1D’ is not displayed although the entry and group was synchronized.

When attempting to start the Console, the ‘java.lang.IndexOutOfBoundsException’ error occurs
(#4935084)

This occurs if the Java 2 Standard Edition 1.4.1 or higher is not updated with the recommended
Patch Clusters for Solaris-based machines. For more details, see the “Installation Notes” section.
User interface options in the Console window are partially displayed (#4955734)

For instance, you may not be able to view the DN mapping rule (in the direction of the Meta View)
in the configuration window of the Participating View. The list box is not displayed. The user
interface does not display the options appropriately.

Workaround

Increase the window size to view all the objects.

The administration Console attempts to stop a connector instance that has not been started
(#4966320)

When you right-click a connector instance, and select Stop Server, a ‘Request sent to stop the
component’ message is displayed although the connector is not started.

Workaround
Always use the Meta-Directory Console to start and stop the connector instances.
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An error message is displayed when you click the ‘Dochome’ link in the Help window of the Fixittool
(#4981016)

Logging on to the Fixittool and clicking Dochome from the Help window results in the ‘Exception
occurred during event dispatching’ message.

When the fixittool.bat file is executed, the Fixittool does not start (#4981020)

This occurs if Meta-Directory is installed in the Program Files directory on Windows-based
machines.

When uninstalling the Join Engine, if the associated Meta View is of the Directory Server 5.2 SP2
instance, the uninstallation operation does not remove the Meta View although it was selected to be
removed (#4983989)

Workaround
Manually uninstall the Directory Server hosting the Meta View.

Two menu options for the ‘Sun ONE Console’ may be displayed on Windows-based machines
(#4900369)

Clicking Start > Programs > Sun ONE Server Products displays two options to start the Sun ONE
Console. One for the Directory Server 5.2 console and the other for the Meta-Directory 5.1.1
Console.

This occurs because Directory Server 5.2 and Meta-Directory 5.1.1 are installed in the same
SERVER_ROOT (prerequisite when installing Directory Server 5.2 with Meta-Directory 5.1.1 on
Windows-based machines).

Workaround
Click any option to start the Sun ONE Console.

The Help button in the Advanced Schedule dialog box is disabled (#4977282)

When defining the refresh schedule, the Help button in the Advanced Schedule dialog box (from
any Participating View > Schedule tab > Click Advanced) is disabled. Online help is not available to
assist you in setting the Advance Schedule options.

Workaround
For details on configuring the options in the Advanced Schedule dialog box, see the “Configuring a
Participating View” section in the Meta-Directory 5.1.1 Administration Guide.

When any UTC-based connector instances is started without enabling the changelog, nsperlconn.exe
fails to execute (#5001859)

After setting the refresh schedule, if any UTC-based connector instance (such as Exchange, Active
Directory, and NT Domain) is started, ‘nsperlconn.exe’ fail to execute. This occurs because the
changelog was not present or not enabled before the connector instance was started.

Page 20 of 38 Meta-Directory 5.1.1 May 2004 « Release Notes



Known Issues and Limitations

When the Console is running for a long period of time, several ‘nsperl manage.pl’ processes are
spawned on Solaris-based machines (#5002959)

This issue occurs if many connector instances are present and if they have never been started. Due
to the large number of connectors present, the manage. pl processes stops responding and are not
killed automatically when it fails. These process could consume large amounts of the CPU.

Workaround

Start all the connectors at least once. Ensure that you install the latest Patch Clusters on the
machine. For information on downloading and installing the latest Patch Cluster, see the
“Installation Notes” section.

When attempting to start the Administration Server, error messages are reported in the Log files
(#5011512)

Error messages such as ‘failure (1151): Adminit: Failed to create psetHandle for chn=<>, cn=nsPerl
<>, cn=Server Group ()..." is reported in the Log files. These error messages do not have any impact
on the normal working of the Administration Server. Ignore these messages and continue to use the
Administration Server.

Meta-Directory Administration Server continuously reports errors in the log files due to failed CGI
requests, on Windows-based machines (#5011713)

If the Console is running continuously for a long period of time (without being used), the ‘Send-cgi
reports: error occurred while sending content to script (10 already pending error)’ is reported in
Administration Server Log files.

Workaround
Make sure you shut down the Console, when it is not being used.

Configuration

The Join Engine processes top level DN (both Meta View and Connector View use dc=<>) when the DN
mapping rules failed, the Participating View gets disabled (#4940297)

Join Engine incorrectly processes the top level suffix using the data flow rules (it applies the DN
Rule or Join Rule to the top level suffix).

Workaround
Use a selection criteria to exclude the top level DN to avoid this issue from occurring.
When viewing log files, the Date option in the Calender cannot be modified (#4777342)

When viewing log files (Console > Status > select Join Engine > Log tab) to set a criteria (such as:
date, month, and year) to display the log files (based on the criteria), the ‘Date’ option cannot be
modified using the Calender.
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Workaround
Enter the date manually to modify it.

The Meta-Directory Console does not process the ‘preferredLanguage’ attribute for a user (#4804790)

During creation or modification of a user, setting the ‘preferred language’ attribute to any value
does not save the change to the Directory Server.

Workaround
Use the LDAPModify command-line tool to set this attribute.

Saving a modified Constructed Attribute rule fails if the rule name contains spaces (#4925860)

When creating a constructed attribute rule (Console > click Meta-Directory > Attribute
Construction tab), spaces can be specified in the name. However, attempting to modify this rule
and save the changes results in the ‘Operation not allowed on RDN’ error. The changes are not
saved.

Workaround
Do not create a name with spaces in the ‘Rule Name’ field.

The user interface for the Refresh Schedule window does not display the modified time interval
correctly for an existing refresh schedule (#4971033)

Modifications to an existing refresh schedule (click Participating View > Schedule tab) is not
reflected appropriately in the Refresh Schedule window. For example, if the default refresh
schedule (every 30 minutes between 0 and 23) is modified to ‘every 1 minute between 0 and 23’,
and you click ‘New’, the Schedule window still displays ‘every 30 minutes between 0 and 23’

Workaround
Once a new schedule is created, click ‘Update’ to display the modified time interval.
A Join Rule cannot be modified if the rule name contains spaces (#4973369)

When attempting to modify a Join Rule, the operation fails if the name entered in the Rule Name
field contains spaces.

Workaround
When entering a join rule name, do not use spaces in the name. For example, ‘Test Rulel’ is an
invalid name.

An existing Attribute Flow rule gets replaced if a new rule has the same name as the existing flow rule
(#4969791)

No warning message is displayed when you create an Attribute Flow rule with the same name as
an existing rule. The new rule replaces the existing rule without displaying an error message.
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Workaround
Verify that the name of the new Attribute Flow rule is not being used by an existing flow rule.

The Console may display the status as ‘refreshing’ although the Connector View is actually ‘disabled’
during synchronization (#4968368)

When attempting to flow two million or more entries from Oracle to the Meta View, an error ‘Failed
to update MDS Config to disable status’ is reported in the log files. The Connector View is disabled,
however, an incorrect status (as ‘refreshing’) is displayed in the Console.

The Meta-Directory Console window may not display all the user interface options (#4955734)

For instance, in the configuration window of the Attribute Flow tab, the drop-down list box is not
displayed appropriately. User interface objects are not visible.

Workaround

Increase the window size to view all the user interface options.

Values specified in the Minute Specifier field in the Advance Schedule dialog box is reset when the
Update button is clicked in the Schedule window (#4997769)

When creating the refresh schedule for a Participating View, the values specified in the Minute
Specifier field gets reverted to the previous values, after you click the Update button in the
Schedule window.

Workaround
Click the Save button (not the Update button), once the values are specified in the Advance
Schedule dialog box (click Participating View > Schedule tab > click Advanced).

Values greater than 59 are not accepted in the minute field (every) of the Schedule window (#4997808)

When creating the refresh schedule for a Participating View, if the value entered in the minute field
(every) is, for example, 70, then only 7 is displayed. The value gets truncated if the value specified is
greater than 59.

Workaround

Do not enter a value greater than 59 in the minute field (every). If the value is greater than 59, enter
the required value in the Minute Specifier field of the Advanced Schedule dialog box (click
Participating View > Schedule tab > click Advanced).

Console

Select any connector and right-click, two menu options for Start and Stop may be displayed (#4885938)

This may occur if the Console was running for long period of time (more than a day).
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An error ‘java.io.EOFException: Connection Lost’ is displayed, when attempting to log on to the
Meta-Directory Console (#4893471)

This occurs if the Directory Server’s port number is specified in the Administration URL field in the
Login dialog box.

Workaround
Use the appropriate Meta-Directory’s port number in the ‘Administration URL’ field.

The Console fails to start on a Solaris-based machine installed with Japanese locale (#4921122)

This occurs, when attempting to log onto the Console, if the recommended patches for the Solaris
environment is not installed. For more information on the required patches, see the “Installation
Notes” section.

When attempting to manage large number of groups in the Console, for example, 20000 entries and
more, the ‘java.lang.OutOfMemoryError’ is displayed and the machine stops responding (#4952041)

When attempting to view the groups in the Connector View that contains 20000 and more entries,
this error will occur.

Adding a new user under an existing user entry or group in the Connector View will fail with the
‘java.lang.ClassCastException’ error (#4966167)

From the Meta-Directory Console, when attempting to add a new user under a existing user entry
in the Connector View fails.

The Console incorrectly save a new Constructed Attribute with the same name as an existing one but
with a trailing space (#4968356)

For example, if a Constructed Attribute with the name ‘test’ exists and a new attribute is created is
‘test ‘(having a trailing space), the Console incorrectly saves the new attribute. When flowing data,
the new Constructed Attribute that contains the rule is executed. In the example, the new attribute
‘test “.

Workaround

When entering the name for the Constructed Attribute rule (from the Meta-Directory Console >
Constructed Attribute window), do not use a name that is being used by an existing rule. Manually
verify whether the Constructed Attribute name is being used by an existing attribute.
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Join Engine

Join Engine stops responding and the flow of entries gets into a cyclic loop when a ModRDN operation
is executed (#4862343)

Workaround

When configuring the DCNS/Manual Refresh schedule, ensure that the poll in either directions
(from Connector View to the Meta View and from Meta View to the Connector View) do not occur
simultaneously.

-Or -

Deselect the options in the Capabilities settings, so that the data does not flow in the reverse
direction. (Set the options either ‘to the Meta View’ or ‘from the Connector View’ direction.)
When attempting to save the DCNS schedule parameters for a data server, an error is displayed in the

terminal window (#4926636)

When setting the DCNS schedule (Meta-Directory > Participating View > DCNS Schedule
window), if values are not entered in any of the fields in the Schedule window, an error occurs. The
schedule with blank fields can be saved, but when the Join Engine processes the schedule
parameters, the blank fields are not validated and an error occurs.

Workaround
Delete this schedule. Create a new schedule; make sure that valid values are entered in all the fields
of the DCNS Schedule window.

When creating the Attribute Flow rules for the Join Engine, the Rule Set is incorrectly saved although
the rule did not have appropriate mappings defined to the Rule Set (#4882443)

A rule added to the Rule Set is not saved if it does not contain any mappings to the Rule Set,
however the Rule Set is incorrectly saved.

Workaround
When a rule is added to a Rule Set, ensure that the rules have valid mappings to the Rule Set.
Special characters that contain ‘%’ are not escaped, when used in the DN Mapping Rules (#4908112)

The ‘Da_e_invalid_DN_syntax’ error is reported in the Join Engine log file, if special characters are
used when constructing DN mapping rules. The entries do not flow and the Connector View gets
disabled.

Modified entries in the data source (for example, Oracle) do not flow to the Meta View if the case of the
attribute values were changed (#4760307)

Incorrect UTF-8 configuration (character set) stops the Join Engine from processing data (#4891349)

The entries get currupted due to the incorrect character set (charset).
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Workaround

Ensure that you use the correct char set . For information on UTF-8 data, see the “Using Special
Characters and UTF 8 data in DN” section in Chapter 5 of the Meta-Directory 5.1.1 Administration
Guide.

Synchronization of entries fails due to insufficient disk space and the Join Engine shuts down
(#4936471)

Synchronization of entries will fail if there is no sufficient disk space. Join Engine does not prompt
you when the disk space is low.

Workaround

Be sure to allocate appropriate disk space before you run an operation that involves
synchronization of several thousands of entries. For details on the machine requirements, see the
“Hardware and Software Requirements” section.

The Join Engine shuts down when the refresh_unlinked operation is executed for the Participating
Views (#4926540)

This may occur if several Participating Views that are configured for the Join Engine have been set
with overlapping refresh schedules for each Connector View.

Workaround
Ensure that the time interval to run the refresh operation between each Connector View is large. Do
not configure overlapping schedules or have a short time interval between each refresh operation.

A scheduled refresh operation starts although the previous refresh cycle was not completed
(#5007778)

This issue occurs if the time interval between two, simultaneously occurring, schedule refresh
operations is small (to synchronize entries from the Connector View to the Meta View).

Workaround

Define a sufficient time interval between each scheduled refresh operation (Join Engine >
Participating View > set parameters in the Schedule tab). Ensure that, while setting the time, the
first refresh operation is completed before the second operation begins.

Modifing an entry in the Connector View results in the error ‘Cannot lock entry’ (#4971919)

When an entry in the Connector View is modified, on synchronization, the Join Engine is unable to
retrieve information of the renamed entry. Mapping rules continues to locate the original entry
(before the entry was modified).

Workaround

Make sure the settings in the Capabilities tab is set (Participating View > select a view > select
Capabilities > deselect options to disable the flow to the Meta View) so that the flow of entries do
not occur in the direction of the Meta View.
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When perl scripts that are used to create the DN mapping rules fail, Join Engine continuous to run
(#4957251)

Join Engine continues to report messages to the log files, although the Perl scripts (for example,
used to create the DN mapping rules) failed to execute due an error in the script.

NOTE Use of PERL scripts to create DN Mapping rules is not supported. For information
and assistance, contact Sun Professional Services. For contact information, see the
“Additional Sun Resources” section.

When performing the Break Link operation on a data of 2.5 million entries for an Oracle Database
connector, memory does not get utilized effectively (#4969116)

Join Engine fails to initialize the DCNS schedule, synchronization of some of the entries in the
Connector View does not occur due to the ‘DCNS_E_TOO_LATE’ error (#4930796)

The Connector View does not refresh the entries due to the ‘DCNS_E_TOO_LATE’ error.

Synchronization is delayed when entries are modified or deleted in the Connector View, when the Join
Engine is performing a refresh operation (#4535865 / #4540609)

This occurs if the schedule to perform synchronization is three minutes or less between either flow
directions (Connector View to external directory and external directory to Connector View). The
Join Engine does not process the changes in the Connector View until it checks the changel og three
times for all the modified entries. This could delay the synchronization of the entries.

Workaround
Do not modify or delete entries in the Connector View, when the Join Engine is performing a
refresh operation.

When performing synchronization with multiple connectors enabled, a Connector View gets disabled
and flow of entries stops (#4878283)

This occurs if the each Connector View (an Oracle Connector View, LDAP Connector View, and
Universal Text Connectors such as Exchange and Active Directory) contains 50K or more entries.
Due to the voluminous data in each Connector View, during synchronization, a Connector View
can get disabled and the flow of entries could stop.

Workaround

Perform the synchronization operation for each Connector View individually. Do not enable all the
Connector Views, when attempting to perform bi-directional synchronization with multiple
Connector Views.

Part Number 817-3899-10 Page 27 of 38



Known Issues and Limitations

Connectors

Lotus Notes Connector

When creating a connector instance, the values entered in the ‘Notes Cert ID Password’ and ‘Domino
Server Name'’ fields are not validated (#4798167)

If incorrect values are entered in these fields (in the New Instance dialog box), the connector
instance is created but an accurate data flow does not occur when the connector is used.

Workaround
Verify whether the values entered in the ‘Notes Cert ID Password’ and ‘Domino Server Name’
fields are correct.

The Lotus Notes connector does not work with Lotus Notes 5.0.11

The LDAP schema search does not work due to a known issue in Lotus Notes 5.0.11.
The Lotus Notes connector does not synchronize access rights and roles

Special characters used when entering the baseDN values are not escaped for the Connector View
(#4927368)

If special characters such as $ # % & are entered in the baseDN values, then problems may occur
during retrieval of changes from the changelog maintained by the retro-changelog plug-in in
Directory Server 5.2.

Workaround
Ensure that the baseDN value does not contain any special characters.

The schedule refresh operation does not start the operation at 2300 hours if the system time is
between 2300 hours through 2400 hours (#4988288)

If the Advanced Schedule option is defined between 2300 through 2400 hours, for example, *
minutes past the hour, every 1 minute between 0 and 23 everyday’, and system time is in the range
between 23 through 24 hours, then the connector does not flow the data to the Connector View
(from the example, after 1 minute from the time it started). It starts the data flow at 00.00 hours.
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The Lotus Notes connector shuts down when flowing large volumes of entries from the Connector
View to the external directory (#4910198)

This occurs due to a bug in Lotus Notes 6.0.1.

When external to directory synchronization is performed, if the Lotus Notes 6.0.1 server has large
volumes of entries (more than 1000) and a Lotus Notes connector is created to connect to the server,
the connector shuts down with ‘Limit on the number of entries or the time was exceeded in Idap
search results’ error. The ‘exception’ occurs as LDAPsearch is executed on the Lotus Notes directory
(6.0.1) although the timelimit to search and sizelimit on the number of entries to return is set to
unlimited.

After reinstalling Meta-Directory, creating a Lotus Notes connector instance fails when the same
parameters of the prior Meta-Directory installation is used (#4927307)

If you enter the same parameters that were used to create the connector instances of the previous
Meta-Directory installation, this problem occurs. Information about the previous connector
instances are not automatically removed from the MySQL database when Meta-Directory is
uninstalled.

Workaround

Before you uninstall the Lotus Notes Connector instances, remove each connector instance
individually using the ‘Remove Server’ option from the Meta-Directory Console. This cleans the file
system, registry (on Windows), configuration-directory, Connector Views, and the created items
(new database and users) from the MySQL database.

Importing an Idif file into the Connector View through initialization fails to synchronize the entries to
the external directory (#4981715)

When al di f file is created using makeldif and imported to a Connector View using theiniti al i ze
command in Directory Server 5.2, the entries do not get synchronized to the external directory.

Workaround
Create the | di f file using makeldif and then use an LDAPbrowser to import the entries to the
Connector View. Now perform the synchronization to the external directory.

Novell eDirectory Connector

Special characters used when entering the baseDN values are not escaped for the Novell Connector
View (#4927368)

If special characters such as $ # % &are used when entering the baseDN values, then problems
could occur during retrieval of changes from the changelog maintained by the retro-changelog
plug-in in Directory Server 5.2.

Workaround
Do not use special characters when entering the baseDN values.
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The Log files could display an incorrect ‘last modified’ time (#4807643)

The last modified time of the log files is not displayed correctly, although the content in the log files
is updated correctly.

When sufficient disk space is not available to complete the synchronization operation, the connector
does not shut down gracefully (#4969161)

The connector stops responding, and the status is displayed as ‘Down’ in the Statistics tab. Log files
do not contain any specific information on the cause.

Schedule refresh operation does not start the operation at 2300 hours if the system time is between
2300 hours through 2400 hours (#4988288)

If the Advanced Schedule option is defined between 2300 through 2400 hours, for example, ‘*
minutes past the hour, every 1 minute between 0 and 23 everyday’, and system time is in the range
between 23 through 24 hours, then the connector does not flow the data to the Connector View
(from the example, after 1 minute from the time it started). It starts the data flow at 00.00 hours.

Values of the ‘unigueMember’ attribute for group entries do not flow from the Connector View to the
external directory (#4899965)

This occurs due an incorrect attribute mapping for the ‘Member’ attribute in the ‘LDAP Group
Object’ in the Novell eDirectory server.

Workaround

Modify the attribute mapping for the Novell eDirectory server attribute ‘Member’ in the ‘LDAP
Group Object’, by specifying ‘uniqgueMember’ as the ‘Primary LDAP Attribute’ and ‘member’ as
the ‘Secondary LDAP Attribute’. Restart the Novell eDirectory server. This schema change allows
the ‘uniqueMember’ attribute for group entries to flow from the Connector View to the external
directory.

After reinstalling Meta-Directory, creating a Novell eDirectory connector instance fails when the same
parameters of the prior Meta-Directory installation is used (#4927307)

If you enter the same parameters that were used to create the connector instances of the previous
Meta-Directory installation, this problem occurs. Information about the previous connector
instances are not automatically removed from the MySQL database when Meta-Directory is
uninstalled.

Workaround

Before you uninstall the Novell eDirectory connector instances, remove each connector instances
individually using the ‘Remove Server’ option using the Meta-Directory Console. This cleans the
file system, registry (on Windows), configuration-directory, Connector Views, and the created
items (new database and users) from the MySQL database.

Page 30 of 38 Meta-Directory 5.1.1 May 2004 « Release Notes



Known Issues and Limitations

When performing the Manual Refresh operation, the data is deleted from the Connector View
immediately but this data is not added again to the Connector View until the next Scheduled Refresh
cycle is performed (#5012391)

This leads to reduced performance of Meta-Directory.

NT Domain Connector

Filters settings do not work for the ‘To NT Connector View’ flow direction although the options can be
set in the ‘Filter Configuration” window (#4930120/ #4994284)

NT SAM does not store data in the form of subtrees. Due to this, irrespective of the filter settings
defined in the direction of the NT Connector View, all the data from NT SAM flows to the
Connector View.

The group members in NT SAM do not get added to an existing group in the Connector View
(#4929445)

Adding existing members in NT SAM to a group in the Connector View fails. The members are not
added to the group.

Workaround
When creating a group in the Connector View, the group must have the nt G oupDonai nl Dattribute
set (this attribute is present in the nt G oup auxilliary objectclass in the Directory Server).

Data is synchronized after the specified End Hour value if the Till Hour value is not specified
(#4917839)

When setting the Schedule parameters, if the Till Hour value is not specified, then on
synchronization, data gets updated even after the specified End Hour value.

When creating a connector instance, if an invalid domain is entered in the ‘NT Domain’ field, the
instance will still be created (#4906612)

This connector cannot be used to flow data although it was created.

Workaround

Use a valid domain name when creating the connector instance.

When the status of the NT Domain Connector View is viewed, the Console may display an incorrect
status as either Stopped or Unknown although it is actually in the Started state (#4914849)

When the Connector View is started and if the server status is viewed using the Administration
Console, the status is displayed is either Stopped or Unknown although the connector is actually in
the ‘started’ state.
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The specified NT Logon hours do not flow correctly (#4993473)

The NT Logon hour is not the same as the one specified, if the time zone is different on the NT PDC
and the machine on which Meta-Directory is running.

Active Directory and Exchange Connector

Connector must run in the full-dump mode to modify a RDN entry or rename a non-owned entry. The
default mode incremental does not work

Workaround
If the entry is modified or renamed, run the connector instance in the full-dump mode to propagate
the change from Active Directory to the other data sources.

Groups are not flown from the Connector View to Active Directory if the group contains one or more
non-existing members (#4899803)

This occurs because Active Directory does not allow a group to contain non-existent members.

Workaround

Enable the ‘Referential Integrity PostOperation’ plug-in in the Directory Server. To enable the
plug-in, from the Directory Server Console > select Configuration tab > select Plug-ins > click
Enable Plug-in > select Referential Integrity PostOperation from the list > click Save.

The Console stops responding if the Refresh option in the Log tab is selected when viewing the log
files (#4915668)

This occurs if the value entered in the ‘Lines to Show’ field (Console > Status > Log tab) to display
the log files is very large.

Workaround
Set a lower value in the ‘Line to Show’ field.

Entries that contain the special character hash (#) in the DN value (owned by the Connector View) do
not flow to Active Directory (#4913269)

When entry created in the Connector View has a DN value that contains the special character hash
(#), for example, dn=CV#$%@$% then this entry does flow from the Connector View to Active
Directory.

Workaround
Do not use the special character hash (#) when entering the DN value.
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Entries created in the Connector View with more than one value for the ‘description’ and ‘mail’ attribute
do not flow to Active Directory (#4916406)

This occurs because the ‘description’ and ‘mail’ attribute are declared as multi-valued attributes in
the Sun ONE Directory Server, however these attributes are considered as single-value attribute in
Active Directory.

Workaround
Do not use multiple values when creating the entry in the Connector View.

The ‘manager’ attribute value does not flow from the Connector View to Active Directory (#4913396)

Database Connector

Refreshing only the unlinked entries in the Oracle Connector View operation could take a long to
complete the operation (#4645846)

When the refresh all unlinked entries in the Oracle Connector View operation is executed, the Join
Engine processes all the entries in the Connector View instead of only those entries that are not
linked. This operation could take a long time to complete if the data is large, for example, 100K
entries and more.

The Oracle Database connector does not flow entries from tables that have composite primary keys
(#4973371)

The Connector View gets disabled when flowing entries that contain composite primary keys.

Workaround
Do not use composite keys in an entry.

NOTE Contact Sun Software Support services to receive a Hotfix that resolves this issue.
This patch is not included in the Meta-Directory 5.1.1 release.

Unable to flow large number of entries or cannot instrument a table that contains several columns
(large scheme) (#4970340, #4781607)

This may occur if the Database connector is attempting to retrieve a very large schema. When
attempting to instrument columns (Data Server > select the appropriate data server > select
Columns > Add ‘Instrumented Columns’) for an Oracle data server, a ‘timeout’ error may occur.
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The Oracle Database Connector View gets disabled if continuous modification to the entries is
occurring in the database during synchronization (#4926600)

After an uninstallation of the database, creating an data server similar to the previous data server
(database) will fail (#4970348)

When you attempt to create a data server similar to the previous data server instance (prior to the
uninstallation of database), an error ‘Changelog is not configured for the user’ message is
displayed. This occurs because the changelog still contains the information of the previous data
server although the schema is successfully removed.

Universal Text Connector

Only the new users flow when the manual refresh operation is executed although a refresh all entries
operation is executed (#4790531)

After creating some users, groups, and organization entries in the Connector View, perform the
manual refresh operation to flow all the entries (Universal Text Connector > Status tab > select
Refresh Updates to the External Directory > from the dialog box, select the ‘Repropagating all
Existing Entries in the Connector View to External Directory Immediately’ option). It does not flow all
the entries, instead only the newly created users flow to the external file (*.out).

For more information on the refresh operation, see “Refreshing the External Data or Connector
View” section in Chapter 2 of the Meta-Directory 5.1.1 Administration Guide.

When entries containing the leading backslash (\) are modified in the Connector View, the ‘Cannot
Save to Directory Server, netscape.ldap.LDAPException:error result (68);Already Exists’ is displayed
(#4787549)

This occurs when the Meta-Directory Console or Directory Server Console is used to modify the
entries that contain leading spaces.

Workaround
Modify these entries with other LDAP browsers or using LDAPmodify.

The schedule time is incorrectly processed if a non-integer, for example, 0.1 or 0.5 is entered in the
minute field of the Schedule window (#4716732)

When setting the schedule (Universal Text Connector > select a Connector View > select the
Schedule tab), if the value entered, for example is 0.5, then on synchronization the contents of the
*.out file is updated only after 5 minutes. Only a whole integer must be entered in the minute field,
the minimum value for the minute field is 1 minute.
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The Console stops responding if the Refresh option in the Log tab is selected when viewing the log
files (#4915668)

This occurs if the value entered in the ‘Lines to Show’ field (Console > Status > Log tab) to display
the log files is very large.

Workaround
Set a lower value in the ‘Line to Show’ field.

When an input file is not available, and if a refresh operation (to the external directory) is performed, all
the data from the Connector View is deleted (#4977992)

This occurs when no input file is present and a manual refresh operation (Console > select Status >
select an UTC instance > select Operation > select Refresh > select Update the > from the list box,
select External Directory) is executed.

Connector shuts down during synchronization of 500K and more entries from the Connector View to
the external directory (#4979945)

The quotations in an attribute value of an entry are improperly placed in the *.out file after
synchronization (#4989288)

When flowing data from the Connector View to the external directory (*.out file), if an entry had
open and closed quotation marks, then the entry in the *.out file contained improperly placed
guotes. For example, if an entry had an initial attribute value defined as “ descri ption”, then after
flowing the data this value is“ “ descri pti on.

The log files are not created if the Log Level is changed from the Off or Debug mode to the Normal
mode (#4997052)

During synchronization of data from the external file to any Connector View, if the log level is
modified from the Off or Debug mode to the Normal mode, no information is reported in the log
files.

Workaround
In the Normal mode (Join Engine > select Log > select Log Level > select Normal), restart the
connector instance to generate the log files.

When processing the data file, ‘nsperlconn.exe’ could consume high CPU (#4972618)

This occurs because the connector process the data file without detecting whether the entries have
been modified since the last scheduled synchronization cycle. This could lead to high CPU usage
and reduced performance of Meta-Directory.
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When the Connector View contains 50K entries and more, then during bi-directional synchronization
the memory utilization is very high and the synchronization operation may not complete (#4997711)

This issue occurs only during the first instance of synchronization of entries using the Universal
Text Connector.

Workaround

When running the synchronization operation for the first time, perform the operation in
uni-directional mode (either from the Connector View to the external directory or the external
directory to the Connector View direction), and then perform the operation in the other direction.

Redistributable Files

Sun ONE Meta-Directory 5.1.1 does not contain any files which you can redistribute.

How to Report Problems and Provide Feedback

If you have problems with Sun ONE Meta-Directory, contact Sun customer support using one of
the following mechanisms:

= Sun Software Support services online at
http: //ww sun. cond servi ce/ support/ sof t war e/

This site has links to the Knowledge Base, Online Support Center, and ProductTracker, as
well as to maintenance programs and support contact numbers.

= The telephone dispatch number associated with your maintenance contract

So that we can best assist you in resolving problems, please have the following information
available when you contact support:

= Description of the problem, including the situation where the problem occurs and its
impact on your operation

= Machine type, operating system version, and product version, including any patches and
other software that might be affecting the problem

= Detailed steps on the methods you have used to reproduce the problem

< Any error logs or core dumps
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Additional Sun Resources

Sun Welcomes Your Comments

Sun is interested in improving its documentation and welcomes your comments and suggestions.
Use the web-based form to provide feedback to Sun:

htt p: // www, sun. coml hwdocs/ f eedback

Please provide the full document title and part number in the appropriate fields. The part number
is a seven-digit or nine-digit number that can be found on the title page of the book or at the top of
the document. For example, the part number of these Release Notes document is 817-3899-10.

Additional Sun Resources

Useful Sun Java Enterprise System information can be found at the following locations:

= Sun ONE Meta-Directory Documentation
http://docs. sun. com db/col [/ S1_MetaDir 511

= Sun Java Systems Directory Server Documentation
http: //docs. sun. coni db/ pr od/ 2121#hi ¢

e SunJava Enterprise System Documentation
http://docs. sun. coni db/ prod/ ent sys#hi ¢

= Java Enterprise System Software Services
htt p: // waw. sun. cond ser vi ce/ product s/ sof t war e/ j avaent er pri sesyst eni

= SunJava Systems Software Products and Service
http: //ww sun. cont sof t war e

= Sun Java Systems Support and Knowledge Base
htt p: // waw sunsol ve. sun. com

e Sun Support and Training Services
ht t p: // www, sun. cond suppor t rai ni ng

= Sun Developer Information
http://devel opers. sun. coni

= Sun Developer Support Services
htt p: // ww. sun. conl devel oper s/ suppor t

= Sun Software Data Sheets
http://wws. sun. conl sof t war e
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